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The whole process of designing the reinforcement details of the concrete structures and then 
generating the structural drawings by ETABS MATE software will be carried out in just four 
simple steps. In this quick start, you will introduce with these four simple steps quickly. 

 
In order to using this software for concrete structure detailing, the project must be model, 

analyze and design in the ETABS first. Specific instructions or restrictions are not required for 
labeling or naming the elements or frame sections that they are using in the ETABS modeling. And 
you can do modeling of your structure in the ETABS without any restrictions or any limitation in 
any way that you feel comfortable. After the modeling and design processes was completed and 
when all results were satisfactory and you decide to start the structure detailing, please follow these 
four below steps carefully for achieve the best results.  
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Generate Model Text File and Save Design Results Files of Structure by ETABS

 
 
 
In ETABS software follow the below instructions to export structure model.  
 
Save model text file in ETABS with the TXT format as follows:  
  

 File Menu > Export > ETABS .e2k Text File…   in ETABS 2013, 2015, 2016 .  
 

Or 
 

 File Menu > Export > Save Model as ETABS .e2k Text File …   in ETABS 9.x.x . 
 
 

 
 

 
Note: Please set the unit system of ETABS software to the kgf-cm before exporting the structure model text file. 
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In ETABS 2013, 2015 and 2016. generate the frame design and shear wall design data file with the 
ACCESS or XML file format as described in the below:  
 

  

 File > Export > ETABS Table to Access …   
 

 Or 
 

 File > Export > ETABS Table to XML … 
 
 

 
 

 

 
 

 
 

After choosing the save format of the design data file as described in top, the ‘Choose Tables’ 
interface will appear as the below image. In this interface, select the ‘Concrete Design’ option to 
save the design results of the frame, ie beams and structural columns, as well as this, please select the 
‘Shear Wall Design’ option to store the results for the structural shear walls, and then deselect all 
other options as the below image. Then by selecting the name and location for the output file, design 
data file will be generated by the software in the specified location. 
 
 

Access 

XML 
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    Of course, you can only save the design data file of the frame structure or just the design 
information of the shear walls in an ACCESS or XML file. To do this, repeat the steps above, and 
then, in order to save only the results of the frame design, in the ‘Select Tables’ interface, you 
should select the ‘Concrete Design’ option only, and only the ‘Shear Wall Design’ option 
should be selected to save only the design results of the walls. And remove all other options.  
 
 
 

 
 

Note1: You must analyze and design your structure before exporting design data file. 
 

Note2: Please, prior to generating the design data file from the file menu, be sure to set the unit 
system of ETABS software on the Kg-Cm option, and then also set the Kg-Cm units again when 
the software asks you the output units as the below image. 
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In ETABS 9.x.x.  you can generate frame design summary file with the RTF or TXT format as follows: 
 

 File Menu > Print Tables… > Concrete Frame Design…  
 

 
 
 
And then select the  Output Summery and  RTF or  TXT Option as the below image 
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In the same way generate the Shear Wall design summary file in the ETABS 9.x.x with the TXT file 
format as the follows: 
 
 

 File Menu > Print Tables… > Shear Wall Design…  
 
 

 
 
 
 
After this, ‘Print Design Table’ interface will be appear as the below image.  
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In this interface, as show in the top image, please select the  Output Summery And  Print to file option 
first and then by clicking on the ‘File Name …’ button, specify the name and location for the shear wall 
design output file.  
 
After this, the shear walls design data file will be generating by the ETABS software in your specified 
location. 
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Import Prepared Files in the First Step into the ETABS MATE Software 

 
 

At this stage, the model files and structural design data files that were produced in the previous step, 
must be imported into the ETABS MATE software. 
 
 

First import the structural model text file to the ETABS MATE as the follows:  
 

 File Menu > Import Structure Model From ETABS Text File  (or use  +  shortcut keys) 
 

Also you can use the  icon  from the software top main toolbar for importing structure text file 
 
 

 
 
 
 

And then import structure design data files into the ETABS MATE as follows:  
 
 

 File Menu > Import Frame Design Summery File 1 (or use  +  shortcut keys) 
 

Also you can use icon  from software top main toolbar for importing structure text file 
 

DCtrl

T Ctrl
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If you have more design data files, Import them to the ETABS MATE as follows:  

 File Menu > Import Frame Design Summery File 2,3,…  (or use icon  from top main toolbar) 
 

 
 
In this case software envelops all design data points for each position of element. So all design values that show 
in the software on the elements are the maximum value of all imported design data files for each position. Also 
software considers these maximum values of each element positions in the reinforcement details design 
procedures. 
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After importing design data file, you can see these data on the each element. Also you can switch the 
information displayed on the elements by using the Layer Display panel as shown in the below images. 
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If your structure contains any Shear Wall objects, please import shear wall design results file to the ETABS 
MATE as follows:  
 

 File Menu > Import Shear Wall Design Summery File (or use  +  shortcut keys) 
 

Also you can use  icon from software top main toolbar for importing shear wall design text file 
 
 
 

 
 
 
 
    In this case all shear wall data such as pier name, assigned section name, demand to capacity ratio, required 
shear steel area and required length of boundary zone will show on all walls in the plan of structure as shows in 
the top image.  
Therefore you can control of this data very easy. Also if there are any problems, software marks them by red 
color. You can also see this data for one wall in all stories by right click on the wall.  
  

DCtrl



    
        

ETABS MATE Quick Start – www.ETABSMATE.ir - www.FARASAEG.ir

PAGE 12

Document No. 18021023

© 2012-2018 -  All Rights Reserved for FARASA Engineering Group

ETABS MATE Quick Start 

 
 

 Adjust the Design Parameters and Run Reinforcement Details Design Procedure 
 
After importing structure to the ETABS MATE, software assigns some default configuration to your project 
automatically. Before start structure reinforcement detail design control software default configuration or 
imported settings such as material properties, rebar cover, beam longitudinal and transverse rebar, rebar overlap 
settings, element reinforcement design parameters, … if necessary and then run design reinforcement 
procedure. 
 
 
In the Define menu you can specify properties such as :  
 

 
 
 
 

 Define Menu > Foundation Thickness 
 
By this command you can specify thickness of your structure foundation. 
 
This value affect on column and shear wall rebar anchor length and in material calculating procedure of 
software. Also this value displayed in column profile drawings detail. 
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 Define Menu > Cover Thickness of Rebars 

 
By this command you can specify concrete cover thickness of rebar for each structural element type 
separately. 
 

These values affect some reinforcement design procedure and also displayed in structural drawings. 
 

 
 
 

 

 Define Menu > Material properties of projects 
 
By this command you can specify concrete compression strength and rebar reinforcement yield stress of the 
structure.  
 
These values affect some reinforcement design procedure such as rebar anchor length and some reinforcement 
design procedure. You can change these parameters only before importing design data to the software; therefore 
this interface automatically appears after importing structure model and allowing the user to easily control these 
values.  
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 Define Menu > Beam Type / Section Details 
 
After importing structure model to the ETABS MATE, software automatically import all frame sections which 
they are used in the structure elements. Then software assigns some design properties such as type name, 
longitudinal and transverse reinforcements to the each type automatically as seen on the following image. 
By this interface you can manage all beam types of the project and also you can view and modify each beam 
type properties such as type name, longitudinal rebar details and shear reinforcement details if necessary, as 
seen in the following image.  
 
After making any changes in this interface all reinforcement details of beam will be reset and you must redesign 
reinforcement details again. 
 

 
 
 
 
 

 Define Menu > Column Section Tie Details 
 
By this interface you can manage frame section of columns similar to the interface of the beams that explained 
in the past part. 
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 Define Menu > Overlap and Anchor length parameters 
 
By this interface you can configure rebar overlap and anchor length parameters that software uses them in tit’s 
reinforcement design procedures. Software allow users to have two several method for configure these 
parameters. In the first method, software calculates overlap multiplier in base of project material properties and 
some parameters automatically. And in the second method users can calculate these multipliers for any rebar 
size and each rebar position, and then specify the calculated values to the related multiplier parameters 
manually. These settings can be seen in the following image. 
 

 
 
Reinforcing Design Configuration 
 

Also if necessary you can configure design parameters to customize software reinforcement design of structural 
elements as you like. These configuration interfaces are available in the Design menu. Some of these interfaces 
described here:   
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 Design Menu > Frame Reinforcing Design Configuration (or use  shortcut key) 
 

In this interface you can configure frame reinforcing design parameters. These parameters can be visible in the 
following image and you can configure them simply.  
 

 

F6
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After making any changes in this interface all frame designed reinforcement details of structure frame will be 
reset and you must redesign reinforcement details again. 
 
 

 Design Menu > Shear Wall Reinforcing Design Configuration (or use  +  shortcut keys) 
 
In this interface you can configure Shear Wall reinforcing design parameters. These parameters can be visible in 
the following image and you can configure them simply.  
 

 

 
 
After changing these parameters, new configuration settings affect on the shear wall reinforcing design 
automatically by clicking on apply change button, and you don’t need to redesign structure again. Also you can 
manage or save this settings to use them in the future project by using the Configuration Settings menu. 
 
 
 
  

F6 Ctrl
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 Design Menu > Design Reinforcing Details (or use  shortcut key) 

Also you can use icon  from software top main toolbar for start design reinforcing details of 
structural elements of your project. 
 
After importing model file and its design data to the software, you can use design command to start the software 
design procedures. By using this command the below interface will be displayed and it will show you design 
progress. This process will take less than one second for ordinary buildings. 
 

 
 

After the completion of the design process, software design results will be visible in the main window, as seen 
in the following image.  

 

F2
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Also you can right click on every element in the respective layer for view more details or changing its software 
suggested design details. For example if you active the  Total Beam Details  layer and right click on a beam, 
the following interface will be displayed. 
 

 
 
 
 
In this interface you can see all structural and design details of the selected beam. And also you can edit 
software designed details very easy by selecting new details or typing any desired details in the respective fields 
and pressing overwrite buttons. If you change and overwrite any details, these changes will be displayed 
immediately on the structure and software will use your overwritten details for preparing structural drawings 
and material lists. 
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Also if you active the  Wall – Pier Information  layer and right click on a wall, the following interface will be 
displayed. 
 
 

 
 
 
In this interface you can see all structural and design details of the selected wall. And also you can edit software 
designed details very easy by typing any desired details in the respective fields and pressing overwrite button. If 
you change and overwrite any details, software will use your overwritten details for preparing structural 
drawings and material lists. 
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 Generate Structural Drawings of Project in the AutoCAD Drawings File Format 
 
After completing the reinforcement details design by software and perform the necessary controls, you can start 
the process of generating structural drawings of your project by software. Structural drawings will be saving 
very quickly in the AutoCAD drawings file format. Generated structural drawings files can be open in the all 
version of AutoCAD and you can easily view or edit drawings in this software.  
For exporting structural drawings, you can use respective there icons in main software toolbar as seen in the 
following image. 
 

 
 
Also you can use the commands in the Export menu for generating structural drawings of your projects as seen 
in the below image. 
 
 

 
 
 
 
 
Generate Frame Drawings 
 
For generating frame structural drawing that contain floor and column details follow the below instruction. 
 

 Export Menu > Export Frame Drawings to AutoCAD  (or use  shortcut key) 

Also you can use icon  from software top main toolbar for generate structural drawings of floor 
and column details of project. 
 
After using this command the export interface that contains drawings parameters will be displayed as seen in 
the following image. 

F3
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In this interface you can configure the drawings parameters if necessary and then generate the drawings. In this 
interface you can see two export buttons: 
 

 
 
By this button you can generate all frame structural drawing and save it to the AutoCAD drawings file format. 
 

 
By this button you can save only the selected active layer drawings in the AutoCAD drawings file format. In the 
other words by this button you can save all objects that can be view in the main graphical window of software in 
the AutoCAD file format. 
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Top image is a sample of some column details of a four story building that generated by software. Rebar list 
table of columns is also can be viewed in the image.  
Drawing engine of software is very fast so that all consumed time for generating the total frame drawing detail 
of usual buildings is only less than one second. 
 
 
Generate Beam Profile Drawings 
 
For generating Beam Profile structural drawing that contains beam geometry and its reinforcement details with 
the position plans, follow the below instruction: 
 

 Export Menu > Export Beam Profile Drawings to AutoCAD  (or use  +  shortcut keys) 

Also you can use icon  from software top main toolbar for generate structural drawings of beam 
profiles of project. 
 
After using this command the export interface that contains drawings parameters will be displayed as seen in 
the following image. 

 

F3 Ctrl
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In this interface you can configure the drawings parameters if necessary and then generate the drawings. In this 
interface you can see three export buttons: 
 

 
By this button you can generate only beam profile structural drawing of the selected beam and save it to the 
AutoCAD drawings file format. 
 

 
By this button you can generate beam profiles structural drawing of all beams in the current story and save it to 
the AutoCAD drawings file format. 
 

 
By this button you can generate beam profiles structural drawing of all beams in total stories and save it to the 
AutoCAD drawings file format. 
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Top image is a sample of some beam details of a four story building that generated by software.  
Also you can manage beam profile in the software as seen in the following image. 
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Generate Shear Wall Drawings 
 
For generating Shear Wall structural drawing that contains wall geometry and its reinforcement details with the 
elevation profile, follow the below instruction: 
 

 Export Menu > Export Shear Wall Drawings to AutoCAD  (or use  shortcut key) 

Also you can use icon  from software top main toolbar for generate structural drawings of shear 
walls of project. 
 
After using this command the export interface that contains drawings parameters will be displayed as seen in 
the following image. 

 

 
 

In this interface you can overwrite software design details and also you can configure the drawings parameters 
if necessary and then generate the drawings. In this interface you can see two export buttons: 
  

F4
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By this button you can generate structural drawing of the current shear wall and save it to the AutoCAD 
drawings file format. 

 

 
By this button you can generate structural drawing of the all shear walls in the project and save it to the 
AutoCAD drawings file format. 
 
 
The following image is a sample of shear wall details of a four story building that generated by ETABS MATE 
software. Rebar list table of the wall is also can be viewed in this image.  
Drawing engine of software is very fast so that all consumed time for generating the total shear walls details of 
usual buildings is only less than one second. 
 

 
 

In this stage all process of element reinforcement details design and structural drawing details of your project 
have been completed.  
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By this software also you can prepare some useful reports such as material lists. For generate material list please 
follow below instruction. 
 

 Export Menu > Estimated Material Report According to Element Type  (or use  shortcut key) 
 

By using this command, software will calculate material list of your project and generate its report. This report 
contains weight of rebar and volume of concrete of total structure by type of elements and by size of rebar as 
seen in the following image. 
 

 Export Menu > Estimated Material Report According to Story Sequence (or  +  shortcut keys) 
 

By using this command, software will calculate material list of selected story of your project and generate its 
report. This report contains weight of rebar and volume of concrete of selected story by type of elements and by 
size of rebar as seen in the following image. 

 

 

F9 Ctrl 

F9 
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